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Syarat Komputer Ujian

Operating System (OS) menggunakan Windows.

PC Ujian memenuhi spesifikasi minimum untuk mengikuti ujian SNPMB.
Terdapat browser Firefox pada komputer.

Terdapat blok Numpad pada layout keyboard .

Dilengkapi headset di setiap PC Ujian.

o s N -

Terkoneksi ke internet (saat ujian putuskan koneksi internet dan pastikan

hanya terkoneksi ke Server Ujian)

Panduan Instal NVDA
1. Unduh aplikasi NVDA pada /ink berikut

https://utbk-snpmb.bppp.kemdikbud.go.id/files/addon/NVDA..rar.
2. Buka installer dengan nama file nvda_2019.1.exe.

3. Pilih I agree, kemudian klik Install NVDA on this computer.
NVDA X

License Agreement
NVDA License M

MNVDA is available under the GNU General Public License version 2, with two special
exceptions.

The exceptions are outlined in the sections "Mon-GPL Components in Plugins and
Drivers” and "Microsoft Distributable Code”,

MNVDA also includes and uses compeonents which are made available under different free
and open source licenses.

Infermation about how to obtain and build the code for yourself is available at
http://community.nvda-project.org/wiki/AccessingAndRunningSourceCode

All applicable licenses are included below.

= GMNU General Public License version 2 =
Most of the source code for NVDA itself is available under this license,
Version 2, June 1981

Copyright (C) 1389, 1991 Free Software Foundation, Inc.

51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

Preamble
The licenses for most software are designed to take away your
[11 agree

Install NVDA on this computer | Create portable copy

Continue running Exit
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4. Pilih Continue untuk melanjutkan, kemudian akan muncul User Account

Control, pilih Yes.

Install NVDA x

T install MVDA to your hard drive, please press the Continue button,

Options
Use NVDA on the Windows logon screen

Create desktop icon and shortcut key (control+alt+n)

Copy portable configuration to current user account

Continue Cancel

5. Tunggu hingga proses instalasi selesai. Jika sudah selesai, pilih OK.

I
o Success hod

o Successfully installed MVDA. Please press OK to start the installed copy.

[ |

6. Jangan update aplikasi NVDA, jika muncul notifikasi terdapat versi baru
aplikasi NVDA.

7. Aplikasi NVDA akan mulai kembali dan mengucapkan dialog selamat
datang, pilih OK.
Welcome to NVDA X

Welcome to NVDA!

Mast cormmands for controlling NYDA require you to hold down the NVDA key while pressing other keys.
By default, the numpad Insert and main Insert keys may both be used as the NVDA key.

You can also configure MVDA to use the CapsLock as the NVDA key.

Press MVDA+n at any time to activate the NVDA menu.

Fram this menu, you can configure MVDA, get help and access other NVDA functions.

Options
Eeyboard layout: | desktop ~
[ Use CapsLock as an NVDA modifier key
[ ] Automatically start NVDA after | log on to Windows
[+] Show this dialog when MVDA starts

OK
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Instal suara Eloquence & Vocalizer

1. Tekan tombol Insert+N, Pilih Tools->Manage add-ons...

preferences - I

Toaols ¥ View log
Code Factory » Speech viewer
Help > Python console

Configuration profiles... Manage add-ons...

Create portable copy...
Run COM Registraticn Fixing tool...

Bevert to saved configuration

Beset configuration to factory defaults

Reload plugins

Save configuration
Donate

Exit

2. Klik Install

Add-ons Manager X
Installed Add-ons

Package Status  Version Author About add-on

Get add-ons... Install... View incompatible add-ons

Close
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Pilih Eloquence.nvda-addon, kemudian klik Open.

Choose Add-on Package File

Organize » MNew folder

~
¢ OneDrive Mame

tmp

VoiceData
|j codefactory-1.0.nvda-addeon
D Eloquence.nvda-addon

[ This PC
_J 3D Objects
[ Desktop
@ Documents
{ Downloads
Music
Pictures

Videos

FE s

Local Disk (C:)
2 CD Drive (D7)
=x iso (\\10.32.0.27)
=x public (\\10.32.0

|_ﬂ Metwork W

NN » ThisPC » Local Disk (C) » Users » DPSl » Downloads » Telegram Desktop » NVDA v | Search NVDA el

Date modified

2019-05-01 11:29
2019-04-05 22:14
2017-03-17 10:34

2013-12-05 10:09

Type Size

File folder

File folder

MNVDA add-on pac... 24512 KB
MNVDA add-on pac... 4973 KB

File name: | Eloquence.nvda-addon

~| | NVDA Add-on Package (*nvda

Klik Yes.

1 Add-on Installation

Are you sure you want to install this add-on?
Only install add-ons from trusted sources,
Addon: Eloquence Synthesizer 0.20131116.02

About add-on... Yes Mo
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3. Klik Instal....

Add-ons Manager

Installed Add-ons

I s

Package Status  Version Author About add-on..,

Eloquence Synthesizer Instal... 0.201.. NVDA User

Add-on help
Disable add-on

Remaove

Get add-ons... | | Install... View incompatible add-ons...

Pilih codefactory-1.0.nvda-addon, kemudian klik Open.

Choose Add-on Package File *
N » ThisPC » Local Disk (C) » Users » DPSl » Downloads » Telegram Desktop » NVDA v | Search NVDA ]
Organize « New folder ==~ [ 0
& OneDrive ~ MName Date modified Type Size
tm 2019-03-0111:29 File folder
I This PC " _
T ) VoiceData 2019-04-05 22:14 File folder
< 30 Objects [ codefactory-1.0.nvda-addon 2017-03-1710:3  NVDAadd-on pac.. 24512 KB
I Desktop [ Eloquence.nvda-addon 2013-12-0510:09 NVDA add-on pac... 4,973 KB
Documents
‘ Downloads
J\ Music
&=/ Pictures
m Videos

‘ams Local Disk (C:)
2 CD Drive (D7)
=x iso (\\10.32.0.27)
=g public \\10.32.0

|_ﬂv Metwork W

File name: | codefactory-1.0.nvda-addon v| |N\|"DAAdd-on Package (*.nvda V|

| Open | | Cancel |
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Klik Yes.

1 Add-on Installation pd

Are you sure you want to install this add-on?
Only install add-ons from trusted sources,
Addon: Code Factory Voices for NVDA 1.0

About add-on... Yes Mo
4. Klik Close.
Add-ons Manager X
Installed Add-ons
Package Status  Wersion Author About add-on..,
Eloquence Synthesizer Instal... 0.201.. MNVDA User
e Add-on help
Code Factory Voices for ... Instal... 1.0 Code Factory <support@codefactoryglobal.com>
Disable add-on
Bemove
Get add-ons... Install... Yiew incompatible add-ons...
Cloze

Aplikasi NVDA akan meminta untuk melakukan restart, klik Yes.
Restart NYDA

Changes were made to add-ons. You must restart NVDA for these changes to take effect.
Would you like to restart now?

PANDUAN INSTALASI APLIKASI
APLIKASIUJIAN PESERTA DIFABLE



ISNPMB  shEP [

Suians: Aasianal Paerin on Mahasisns Saru
W |@Dalsi Pengsloamn Penguisn Fenddiken

PANDUAN INSTALASI APLIKASI
APLIKASI UJIAN PESERTA DIFABLE



EOSNPMB  sNEP ()

5. Untuk menginstal suara, tekan tombol Insert+N, Pilih Code
Factory->Code Factory Vocalizer.

Preferences b
Tools »

Code Factory » Code Factory Eloquence
Help ¥ Code Factory Viocalizer

Configuration profiles...
Revert to saved configuration
Reset configuration to factory defaults

Save configuration

Daonate

Exit

6. Klik Enter Key.

Vocalizer NVDA

s We hope you are enjoying the evaluation of Vocalizer for
4@‘ Windows, Remember to purchase a license before the trial expires
to continue using great voices.

To continue the evaluation select 'Continue’. To buy it now, select
'Buy Online' and if you have a license, please select 'Enter Key',

Trial Days Left: &

Continue Buy Online Enter Key
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Kemudian masukkan license key yang sudah di kirim ke email kortik pada

box Enter Activation Key, pilih Activate.

) Vocalizer NVDA

Voices Settings About

@ Vocalizer MVDA 1.1.0
Copyright 2015 by Code Factory, 5.L.

Communications, Inc,

Trial period active. Days remaining: &

Your Computer ID is:

Muance and Vocalizer Expressive are registered trademarks of Nuance

| 35530EFEF2CITCT-ATS57FF3-1039F3F 1

Enter Activation Key:

Deactivate

Activate

7. Ceklis | fully understand the license system and it's activation methods,

10

kemudian klik Activate

Vocalizer NVDA

Flease note that the product can be activated on 3 computers. In case you need to
introduce major changes in your PC such as replacing/formatting the hard drive or upgrading
the operating system, you must first deactivate your license from the machine. This will free
one of the activations so that you can use it later in the same computer or a new ane.

Otherwise you may loose your activation permanently.

For mare information about licensing please visit Code Factory product page.

[]1 fully understand the license system and it's activation methods.

Activate

et
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8. Setelah berhasil diaktivasi klik OK

1

@ Vocalizer NVDA

Voices Settings About

@ Vocalizer NVDA
Copyright 2015 by Code Factory, S.L.

Muance and Vocalizer Expressive are reqgistered trademarks of Muance

Communications, Inc.

Open Source Licenses

Trial period active, Days remaining: &

110

o The product is registered.

—1 =

m

Vocalizer NVDA pod

Deactivate

Activate
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Kemudian klik OK, untuk menutup aplikasi Vocalizer NVDA.

E

& Vocalizer NVDA

Voices Settings About

Vocalizer NVDA 1,10
Copyright 2015 by Code Factory, 5.L.

x

Muance and Yocalizer Expressive are registered trademarks of Muance

Communications, Inc.

Dpen Source Licenses

The product is registered.

Your Computer ID is:

| 35530E2F EF2COTCT-ATS5TFF3-1039F 3F 1

Enter Activation Key:

| e

Deactivate

This preduct is registered to Universitas Indonesia
(fandi.akhmad @ive.com)

Activate
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9. Pada tab Voices pilih Indonesian (Damayanti), klik tombol Install.

& Vocalizer NVDA b
Voices Settings About
Listen
Indonesian Damayant
Install
‘ ’. Italian Alice Uninstall

‘ ' Ttalian Federica
‘ ' Ttalian Luca
‘ ' Ttalian Pacla
. Japanese Kyoko
. Japanese Otoya

w Kannada Alpana

Pilih Premium High, kemudian klik OK.

Select Voice Quality >

Several voice gualities are available for the selected voice. Please select
the woice quality you wish to install. Higher gualities will require mare
SpaCe on your computer,

Premium High e

13
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Aplikasi akan mendownload voice Indonesian Damayanti.

Voice Installation *

Indonesian Damayant

Downloading... 5.6 MB [ 424.6 MB (1%) 909.3 kB/s

7 minutes left.

10. Setelah selesai instalasi aplikasi akan melakukan restart, klik OK.

YVocalizer VDA oo

Your screen reader may need to be re-initialized in order for
its voice list to be updated.

11. Jika proses download voice Indonesian Damayanti gagal, seperti dibawah
ini

@ Vocalizer NVDA

Voices Seftings About

- Listen
Bahasa Indonesia Damayanti
et Install
@ Bahasa Arab Laila Uninstall
e T
Voice Installation X

Could not connect to server to download the voice. Make sure you
have a working Internet connection.

Bahasa Belanda Xander

Bahasa Belgia Belanda Ellen

K||k Ok lalu keluar atau exit dari aplikasi NVDA.

14
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12. Pada hasil ekstrak file NVDA.zip, salin folder VoiceData

Name Date modified Type Size

== tmp 31/01/2024 15.10 File folder

~ VoiceData 31/01/2024 15.10 File folder

D codefactory-1.0.nvda-addon 17/03/2017 10.34 NVDA add-on pac... 24512 KB
D Eloquence.nvda-addon 05/12/2013 10.09 NVDA add-on pac... 4973 KB
ﬁ MathPlayerSetup.exe 30/03/2019 11.52 Application 5.587 KB
(3 nvda_2019.1.exe 26/03/2019 12.41 Application 23.524 KB
D vocalizer-Damayanti.dic 01/05/2019 11.40 ttfile 3KB

13. Pada fitur pencarian Windows, buka Explore NVDA user configuration
directory

[M Explore NVDA user configuration S
directory

Kemudian buka folder addon\codefactory\File. Tempel folder VoiceData.

x +
C O > UNPAD > AppData > Roaming > nvda > addons > codefactory > File > Search File
¢] @D W A oSotv = View
Name " Date modified Type Size

~ VoiceData 13/03/2024 16.26 File folder

CFResources.dll 13/03/2024 14.18 Application extens... 889 KB
4] Crsettings.ini 13/03/2024 14.21 Configuration setti 1KB
D deu.syn 13/03/2024 14.18 SYN File 1.115KB
ecidll 13/03/2024 14.18 Application extens... 179 KB
EloquenceNVDA.dIl 13/03/2024 14.18 Application extens. 2290 kB
2 EloquenceNVDAUlLexe 13/03/2024 14.18 Application 4.844 KB
@ EloquenceTTS.dll 13/03/2024 14.18 Application extens... 1.583 KB
D eng.syn 13/03/2024 14.18 SYN File 1751 KB
D enu.syn 13/03/2024 14.18 SYN File 1711 KB
D esm.syn 13/03/2024 14.18 SYN File 783 KB
[ espsyn 13/03/2024 1418 SYN File 787 KB
D finsyn 13/03/2024 14.18 SYN File 1.067 KB
D fra.syn 13/03/2024 14.18 SYN File 1.127 KB
D fresyn 13/03/2024 14.18 SYN File 1.203 KB
D ita.syn 13/03/2024 14.18 SYN File 815 KB
LocaleCommon.dil 13/03/2024 14.18 Application extens. 2092 KB
msver110.dIl 13/03/2024 14.18 Application extens. 855 KB
[ ptousyn 13/03/2024 14.18 SYN File 783 KB

15
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14. Buka kembali Aplikasi NVDA, kemudian pada tab Voices pilih
Indonesian (Damayanti), pastikan tombol Install sudah tidak aktif.

@ Vocalizer NVDA

Voices Settings

Listen
Bahasa Indonesia Damayanti

Installed (Embedded High)
Install

Bahasa Inggris Amerika Nathan
Installed (Embedded High) Uninstall

Bahasa Arab Laila

Bahasa Arab Maged

Bahasa Arab Tarik

Bahasa Basque Miren

Bahasa Belanda Claire

Bahasa Belanda Xander

00000 R D
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PANDUAN INSTALASI APLIKASI
APLIKASIUJIAN PESERTA DIFABLE



@S\PMB

eI

) anon  |\SN|BT

Ubah Suara (Bahasa Inggris / Indonesia)

1. Klik tombol Insert+N, Pilih Preferences->Settings...

Preferences
Tools

Code Factory
Help

Configuration profiles..,
Bevert to saved configuration
Reset configuration to factory defaults

Save configuration

Donate

Exit

* Settings...

* Speech dictionaries *
» Punctuation,/symbeol pronunciation...

* Input gestures..,

2. Pilih tab Speech, klik tombol Change....

17

MNVDA Settings: Speech (normal configuration) X
LCategories:
General ~

Synthesizer
o

Braille

Keyboard

Mouse

Review Cursor

Input Compaosition
Object Presentation
Browse Mode
Documnent Formatting
Windows 10 OCR
Advanced

Windows OneCore voices Change...

Voice: | Microsoft David

Rate: '
Pitch: '

Volume: '

[~] Automatic language switching (when supported)
[] Automatic dialect switching (when supported)
Punctuation/symbeol level: | some

[+ Trust voice's language when processing characters and symbals

Include Unicode Consortium data (including emaji) when processing characters and symbols
P ; — al= v

oK Cancel Apply
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3. Pada kolom Synthesizer pilih Code Factory Vocalizer, Kemudian klik OK.

Select Synthesizer X
Synthesizer: |Code Factory Vocalizer
Output device: | Microsoft Sound Mapper
Audic ducking mode: | No ducking s
oK Cancel
4. Pilih tab Keyboard, ceklis box caps lock.
NVDA Settings: Keyboard (normal configuration) X
Categories:
General SRS ~
Speech Keyboard layout: | desktep
Braille Select NVDA Modifier Keys
Keyboard ¥ caps lock
Mouse numpad insert
Review Cursor insert
Input Compaosition
Object Presentation Spsaiiiped Baees
Browse Mode [[]Speak typed wards
Document Formatting Speech interrupt for typed characters
Windows 10 OCR = . A
Advanced peech interrupt for Enter key
[] Allow skim reading in Say All
Beep if typing lowercase letters when caps lock is en
[[1Speak command keys
Play sound for spelling errors while typing
Handle keys from cther applications v
QK Cancel Apply

18
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5. Klik OK untuk menutup menu NVDA Settings.

NVDA Settings: Keyboard (normal configuration) *
LCategories:

General Kevboard | .

Speech Keyboard layout: | desktop ~

Braille Select NVDA Modifier Keys

Keyboard

Mouse numpad insert

Review Cursor insert

Input Composition

o
Object Presentation Speeblvped halacis

Browse Mode []5peak typed words
Document Formatting Speech interrupt for typed characters
Windows 10 OCR

Advanced Speech interrupt for Enter key
[] Allow skim reading in Say All

Beep if typing lowercase letters when caps lock is on
[]5peak command keys

Play sound for spelling errors while typing

[#] Handle keys from other applications W

oK Cancel Apply

6. Pada hasil ekstrak file NVDA .zip, salin file vocalizer-Damayanti.dic.

~

Mame Date modified Type Size

trp File folder

VoiceData File folder
D codefactory-1.0.nvda-addon NVDA add-on pac... 24512 KB
D Eloquence.nvda-addon 2013-12-05 10:09 NVDA add-on pac...
MathPlayerSetup.exe 2019-03-30 11:52 Application
(3 nvda_2019.1.exe 2019-03-26 1241 Application
D vocalizer-Damayanti.dic 2019-05-01 11:40 Text Document

7. Pada fitur pencarian Windows, buka Explore NVDA user configuration
directory

[M Explore NVDA user configuration S
directory

Kemudian buka folder speechDicts\voiceDicts.vi\vocalizer. Tempel file

vocalizer-Damayanti.dic.

I = | vocalizer — [m| X
Home Share View v 0
<« - A4 » DPSI » AppData » Roaming * nvda » speechDicts * woiceDictswl » vocalizer v & Search vocalizer =]

Name Date modified Type Size
#F Quick access
D vocalizer-Damayanti.dic 05-01 11:40 Text Document 3KB
¢ Onelrive
3 This PC
| =¥ Network

19
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Instal MathPlayer

1. Double klik file MathPlayerSetup.exe, kemudian akan muncul User

2. Pilih I accept the terms in the license agreement, klik Next.

20

Account Control pilih Yes.

ﬁ MathPlayer - InstallShield Wizard >

Welcome to the
MathPlayer 4.0
Install Wizard

Before proceeding, please close all
Microsoft Word and Outlook windows
(Cutlook makes use of Word).

After installation, you will need to restart
Internet Explorer and PowerPoint in order to
use this new version of MathPlayer.

ﬁ MathPlayer - InstallShield Wizard

License Agreement
Please read the following license agreement carefully.

License Grant

The accompanying Software is a proprietary product owned by Design Sdence, Inc., and is
protected under U.5. and international copyright law. The Software may be used only on
computers owned, leased, or otherwise controlled by you. ¥You may not reverse assemble,
reverse compile, or otherwise translate the Software.

Limited Warranty

Design Science makes no warranties, induding warranties of merchantability and fitness for a
particular purpose. Any remedy under this warranty is limited to return of the Software to
Design Scence for replacement, Design Scence exdudes any warranty coverage for
incidental or conseguential damages. Some states do not allow limitations on implied
warranties, so some of the above limitations may not apply to you.

{* [ accept the terms in the license agreement

(" I do not accept the terms in the license agreement

< Back | Mext = | Cancel

PANDUAN INSTALASI APLIKASI

APLIKASIUJIAN PESERTA DIFABLE



&‘;E:j SN|BT

3. Setelah instalasi selesai, pilih Yes dan klik OK.

2]

MathPlayer - InstallShield Wizard

Extracting Files
The contents of this package are being extracted.

Pleaze wait while the Installshield Wizard extracts the files needed to install
MathPlayer on your computer. This may take a few moments.

Extracting geometry.tdl...

|

Inztallshield

= Back I ek = I

Cancel
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Deactivate Lisensi Aplikasi NVDA

Deactivate License (Jika Ujian Sesi terakhir Selesai)

1. Tekan tombol Insert+N, Pilih Code Factory->Code Factory Vocalizer.

Preferences ¥

Tools >

Code Factory > Code Factory Eloquence
Help > Code Factory Vocalizer

Configuration profiles...
Bevert to saved configuration
Beset configuration to factory defaults

Save configuration
Donate

Exit

2. Pilih tab About, klik Deactivate

oy Vocalizer NVDA

Voices About

y

Settings

Vocalizer MVDA 1.1.0

Copyright 2015 by Code Factory, S.L.

Communications, Inc,

Dpen Source Licenses

The product is registered.

Your Computer ID is:

Muance and Vocalizer Expressive are registered trademarks of Nuance

| 35530E2F EF2CO7CT-AYSSFF3-1039F3F1

Enter Activation Key:

This product is registered to Universitas Indonesia
(fandi.akhmad @live.com)

Activate

22
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Pilih Yes.

Vocalizer MVDA

computer?

o Are you sure you wish to deactivate your license from this

fes

Pilih Yes.Klik Ok.

Yocalizer NVDA

Your license has been successfully deactivated from this
computer,

4. Klik Ok untuk minimize aplikasi NVDA.

23

) Vocalizer NVDA

@ Vocalizer MVDA
Copyright 2015 by Code Factary, 5.L.

Communications, Inc,

Dpen Source Licenses

Trial period active, Days remaining: 5

Your Computer ID is:

Voices Settings About

1.1.0

Muance and Vocalizer Expressive are registered trademarks of Nuance

| 35536E2F-EF2C97CT-ATS5TFF3-1039F3F 1

Enter Activation Key:

Deactivate Activate
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